
 

 

1 Software Update Notification: PSS0017-05 

Software Update Notification 
PSS0017-05: Mastersizer 2000 E v5.60 software 

Abstract 
This document details the release of software PSS0017-05. This is version 5.60 of software for the Mastersizer 2000 E laser 
diffraction system. It covers software issues fixed and new features introduced. This information is required to perform a risk 
analysis to determine if the software should be installed. In this risk analysis the benefits of the new features provided and 
resolved software issues must be weighed against the risk of new issues that may be introduced to vital areas of the software 
or possible changes to the results of future analysis. Installation instructions are provided. 

 

Note: This software update only relates to the English and Japanese language versions of the Mastersizer 2000 
software. French, German and Chinese language options are only available for v5.12 of the Mastersizer 2000 software. 
The installation files for these versions are included on this software CD-ROM.  

Installation 
It is assumed that you have authority to install or update software within your facility. It is also assumed that you have 
Administrator rights for the system upon which the software is installed, as this is a requirement of the installation process. If 
you do not have this authority please consult with your I.T. support department before proceeding. 

Minimum System Requirements 
The key minimum requirements for running this software are highlighted in the table below:  

Feature Specification 

Memory 512MB, although it is recommended that at least 1024MB is 
available when using Windows XP and 2GB when using 
Windows Vista. 

Hard Disk Storage 80Gbyte 

Additional Storage Media CD-ROM drive 

Display Resolution 1024 x 768 

Connectivity 1 RS232 COM port 

Windows Vista Business Edition TM 
Windows XP Professional TM with SP2 or higher installed 
Windows 2000 Professional TM with SP4 or higher installed 

Operating System 

 

Although the software has been tested using Windows 2000TM and Windows Vista Business Edition TM, Windows XP 
Professional TM is the preferred operating system. 
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Instrument compatibility  
The Mastersizer 2000 v5.60 software is backwardly compatible with all prior versions of Mastersizer 2000. 

 

Note: In common with a large number of applications that undergo significant updating, data files produced by earlier 
versions will be compatible with this release but data files produced by this release may not be legible by earlier 
versions. Where there is regular correspondence between systems, users are advised to ensure that all instruments are 
updated to the same level. 

Installation Instructions 
The Mastersizer 2000 software is provided on one auto-loading CD-ROM. Inserting the CD-ROM into a system configured to 
auto-run a CD will run the installation program automatically. If your system does not support this feature run the 
\setupMS2K.exe program from the root directory of your CD drive. 

 

Note: In order to comply with the security requirements for the Windows TM operating systems, the directory structure 
used by the Mastersizer 2000 software has been changed. Please refer to the Known Issues section of this document 
in order to understand these changes prior to installing this software. 

 

Note: Some of the changes made to the control of the Mastersizer 2000 dispersion accessories require the accessory 
firmware to be updated when upgrading previous versions of the Mastersizer 2000 software.  

Please contact Malvern Instruments for information regarding how to upgrade the accessory firmware. 

Operating System Component Updates 
Mastersizer 2000 v5.12 for French, German and Chinese language systems can be installed on systems running Windows 
NT 4.0 TM. However, some of the Microsoft components required for the operation of the Mastersizer 2000 system may not be 
present within Windows NT TM operating system. This includes the Microsoft MDAC 2.5 components as well as Internet 
Explorer v4.1.  

The Mastersizer 2000 software installer will automatically detect if any operating system updates are required for these 
software versions. The required updates are included on a separate installation CD (PSS0018-01: Operating System 
Component Update Suite) for all the supported languages and are also available from the Microsoft Internet site for 
download. 

Uninstall Procedure 
The Mastersizer 2000 software can be uninstalled using the standard Add/Remove Programs feature in the Windows 
‘Control panel’. 
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New Features 

Windows Vista™ Support 
Mastersizer 2000 v5.53 or higher has been modified to run on Windows Vista™ and has been fully tested using Windows 
Vista Business Edition. While it has not been tested on the other available Windows Vista variants, we are not aware of any 
potential compatibility issues. 

21 CFR Part 11 Support 
Mastersizer 2000 v5.xx software includes full support for customers who require the software to run within a 21 CFR Part 11 
compliant environment. This includes new features relating to software access control, measurement auditing and the setting 
up of SOPs. These features are enabled by use of a software feature key which is specific to each instrument. Please contact 
your local Malvern Representative if you wish to obtain a feature key in order to enable the software’s 21 CFR Part 11 
features on your system. 

Full details of the 21 CFR Part 11 features available within the Mastersizer 2000 software can be found in the following 
documents included on the Mastersizer 2000 software CD-ROM: 

• 21 CFR Part 11 User Guide (MRK1065-01) – provides a full description of the software features associated with 
21CFR Part 11, including the software’s security system. 

• 21 CFR Part 11 Compliance Guide for the Mastersizer version 5.12 or later (MRK537-03) – background 
information for users relating the functionality provided within the Mastersizer 2000 software to each of the 
requirements mentioned with 21CFR Part 11. 

Fixed Issues 
The following Software Change Requests (SCRs) have been implemented in version 5.60 of the Mastersizer 2000 software: 

 

SCR 
Number 

Description Type Comments 

6398 When the ‘ignore first measurement’ option is enabled in a dry 
measurement SOP, it is not applied consistently. 

Bug Fixed 

6769 If the application is launched by double clicking on a measurement 
file in Windows Explorer, the application crashes on exit.  

Bug Fixed 

7187 Russian characters do not display correctly. Bug Fixed 

7190 The instrument intermittently reports a CRC failure for the 
characterisation data. 

Bug Fixed 

7191 A "kernel FLASH CRC error" message is reported intermittently. Bug Fixed 

7266 The Audit Trail occasionally shows measurements created by an 
‘unknown’ user. 

Bug Fixed 

7267 The system occasionally locks-up when the live display is active. Bug Fixed 
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SCR 
Number 

Description Type Comments 

7326 In remote mode, the background alarm should stop the SOP. Improvement Implemented 

7424 Problems within instrument control when using the Variflow options 
for the Hydro 2000G accessory. 

Bug Fixed 

7487 The advice links for the SOP pages do not seem to work. Bug Fixed 

7609 [CFB 00748] The code for ignoring the first result for dry powder 
measurements causes strange SOP values to be recorded. 

Bug Fixed 

7713 Some of the help buttons do not function correctly. Bug Fixed 

8085 Dry accessory measurements do not terminate correctly. Bug Fixed 

8087 Negative values displayed in some particle size distribution report 
tables. 

Bug Fixed 

8088 The Mastersizer 2000 application does not start when a user double-
clicks on a measurement file. 

Bug Fixed 

8118 The dates displayed in report footer are not localised for foreign 
language systems. 

Bug Fixed 

8232 Instrument status can become corrupted, causing the ER/ES settings 
to be reset within the system registry. 

Bug Fixed 

8446 Edit->Copy parameter causes the application to crash. Bug Fixed 

8495 
Parameters with names longer than the boxes in which they are 
displayed can't be selected because of tool tips getting in the way. 
This applies when setting the Export or View select fields. 

Bug Fixed 

 

In addition, the following changes were made between v5.53 and v5.54: 

 

SCR 
Number 

Description Type Comments 

6772 New lot and batch labels are not added to the label list correctly. Bug Fixed 

6785 Displaying the manual configuration screen for the Autosampler 2000 
accessory causes the software to crash. 

Bug Fixed 
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SCR 
Number 

Description Type Comments 

6787 Files are exported in UNICODE rather than ASCII format. Bug Fixed 

6788 Batch printing a report which includes a custom calculation causes 
the software to crash. 

Bug Fixed 

6794 The default value for background quality alarm should be 300 units 
rather than 200. 

Improvement Implemented 

6820 Yellow is one of the default line colours for graphs in v5.53 software. 
This colour should be removed. 

Improvement Implemented 

7031 When an SOP is edited some parameters are set to zero that should 
not be. This impacts result emulation most noticeably. 

Bug Fixed 

 

The software update notification documents relating to previous versions of the Mastersizer 2000 software are available from 
the support section of the Malvern Instruments website (www.malvern.com). Please refer to these documents for details of 
the new features released within each version of the Mastersizer 2000 software. 

Deletions 
No program features have been removed in this version of the Mastersizer 2000 software. 

Known Issues 
New Directory Structure 
Since the launch of Windows 2000TM, the WindowsTM operating system has been set up to discourage the storage of data 
files into the Program Files group of folders. In order to avoid the security access problems associated with using the 
Program Files folders, this version of software has been set up to store data in the shared folders. The root Mastersizer 2000 
data directory will therefore be set to: 

• For Windows VistaTM: C:\ Users\ Public\ Public Documents\ Malvern Instruments \ Mastersizer 2000 
• For Windows XPTM: C:\ Documents and Settings\ All Users\ Shared Documents\ Malvern Instruments\ Mastersizer 2000 
• For Windows 2000TM: C:\ Documents and Settings\ All Users\ Documents\ Malvern Instruments \ Mastersizer 2000 

 

When updating an earlier software version, the software installation procedure will automatically move all of the user data 
from the previous root directory (C:\Program Files\ Malvern Instruments\ Mastersizer 2000) into the new directory structure.  

 

Note: It is recommended that users back-up their data prior to carrying out the installation process and should note both 
the old and new locations of the Mastersizer 2000 data files. 

 

Changes to SOP version control 
In previous software versions a mismatch could be observed between the SOP version number reported from the Compare 
SOPs dialogue and the version number reported on the records view. This inconsistency has been addressed in version 5.30 
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and above of the Mastersizer 2000 software. However, the fix applied may cause the reported version number to change on 
result printouts. The observed behaviour will be: 

• If the SOP version shown in the Compare SOPs dialogue was the same as the SOP version number reported on the 
records view then no change will be observed. 

• If the SOP version shown in the Compare SOPs dialogue was lower than the SOP version number reported on the 
records view then the SOP version will be taken to be the higher value. 

As such, it is possible that some users will notice an increase in the SOP version number reported in the software. 

Scirocco Venturi Identification 
In version 5.30 and above, the ability to detect the type of venturi fitted to the Scirocco dry powder feeder has been provided. 
This requires the setting of one of the accessory identification switches (the A/B switch). As such, this feature will only work 
correctly for new Scirocco dry powder feeder units where the identification switch has been set according to the venturi type. 
For older Scirocco systems users should select the “Original Configuration” option in the SOP settings associated with the 
Scirocco in order to disable the auto-sensing feature. If users want to enable the ability to sense the venturi type for older 
Scirocco systems then please contact your local Malvern representative. 

Upper Size Limits and Dv100 reporting  
 

Note: The use of the Dv100 as a control parameter is not advised, as this parameter is subject to large variations based 
on small changes in the dispersion and sampling regime. Malvern recommends that users use percentiles such as the 
Dv90 or Dv95 to provide control of the upper end of the size distribution. 

 
In previous software versions, some variability in the reported upper size limit for Mastersizer 2000 results was observed. 
This was caused by an incorrect tendency for the analysis to report an extremely small volume percentage of material 
(>0.0001%) at the limits of the analysis. This, coupled with the calculation method used for percentiles, caused the reported 
Dv100 to change considerably between measurements. 

In version 5.30 or above the analysis error associated with the reporting of small volumes of material at the analysis limits 
has been fixed and a new method for calculating the Dv100 has been implemented. These changes may affect the Dv100 
reported by the analysis, especially for those samples where the Dv100 value was always reported to be 2000μm. Testing 
has shown, however, that the shift in the reported values for percentiles below the Dv99.5 is negligible. 

File sizes 
In order to increase program performance, measurement records are kept in memory. For customers with a large number of 
measurements in a single file, this will affect the system performance by consuming large amounts of available memory. The 
best practice is to keep the number of measurement records in a single file to less than 1000. It is recommended that new 
files should be created on a regular basis in order to keep the record count per file to less than 1000. 

Installing an earlier version after un-installing v3.x. or above 
To replace the Mastersizer 2000 application with another version, it is necessary to first uninstall the software using the 
command provided. When moving from version 3.x to version 2.00 or below, you must replace the Mastersizer 2000.ini file 
for the operation to succeed. Once the later software has been uninstalled, rename the Mastersizer 2000.ini file 
Mastersizer 2000.in3. Then install the earlier version. If this is not done, the old application will not run correctly.  

New security system 
The new security system introduced in v5.00 and higher is incompatible with the pre-existing ‘Secure Layered Access’ 
system. If v5.00 or higher is installed on a system with v4.00 or lower, the security settings will have to be reconfigured to add 
users and groups. 
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Autosampler - flashing accessory icons 
The new version of the instrument firmware (FIDACS v1.03 or greater) must be downloaded to any instrument where an 
autosampler is to be used.  A full description of how to do this is included in the contents.txt file, stored in the root directory of 
the installation CD. 

Autosampler – engineering screen is not painted under XP themes 
When showing the tabbed engineering screen (only available to Malvern service representatives) under windows XP the tab 
contents are not correctly displayed. Clicking on another tab and then returning repaints the screen correctly. 

Localised number formats 
The software does not function correctly if the number format set in the localisation settings of the system has the comma 
character either as the decimal marker of as the separator for thousands. The remedy is to modify the number format to 
exclude this character. This can be done in the Regional Options of Control Panel. 

Lactose Refractive Index 
The Lactose refractive index listed in the Mastersizer 2000 particle property database (1.347) is incorrect. The correct value 
for Lactose should be between 1.52 and 1.54. The entry has not been changed, as this could affect existing methods. If users 
wish to use the correct value, they are requested to set up a new entry in the software’s particle properties database. 

Edit-Copy Parameter 
In Mastersizer 2000 version 5.60, a bug fix has been applied to ensure the Edit->Copy function associated with report views 
does not cause the software to crash. Users should note that this menu option will only copy the first parameter added to the 
report during report creation. If the copying of multiple parameters is required, users are advised to set up an export template 
containing the desired parameter set. The File->Export Data command, available when the Records view is active, can then 
be used to export the parameters to the Windows clipboard. Alternately, if the export template is set as the default template, 
the Edit-Copy menu option can be used to transfer the parameters to the clipboard. 

Accessing Measurement Files via Windows Explorer 
In the past, it has been possible to open a Mastersizer 2000 measurement file by double-clicking on the file from within 
Windows Explorer. This caused the Mastersizer 2000 software to start with the selected file opened. The operating system 
mechanism required to enable this to occur (Dynamic data exchange) has been removed from Windows VISTA. For this 
reason, this mechanism for opening files has been disabled in v5.60 of the software. Double clicking on a Mastersizer 2000 
measurement file will cause the software to start, but users will have to browse for the file using the File->Open menu option 
within the software. 

If you are using Windows XP, a mechanism does exist for re-enabling the ability to open files from within Windows Explorer. 
Please contact your Malvern Representative for a technical note describing how this can be done. 
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